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Meeting Schedule

Mar 8
Apr 12
May 10
June 14
July 12
Aug 9

Sept 13
Oct 11
Nov 8

Dec  TBA
Holiday Party

Submit ”Cover Photo” 
material to  the 

Newsletter Editor 
Suzan Meldonian,

561-394-6391 
or e-mail:

newsletter@sfups.org  
Info about the image

is appreciated.
DEADLINE IS THE 

25th!

NEXT MEETING:
Tues. Mar 8 2011

7:30 PM at
El Palacio

Sports Hotel
21485 N.W. 27th Ave, 

Miami, 33056
305-621-5801

All images in this newsletter are copyright protected and may not be used without written consent of 
the photographer. For information on how to contact the photographer contact the Newsletter Editor.
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Presented by Sharon Baron
Tips ‘n Tricks: contests

Susan Mears & Lightroom Tips

Destinations: Florida Springs by Ximena Olds & David Vanderveken

Members in the News!

 2011 Intra Club Contest Subjects

 Links to Photo Contests, Classifieds,

Linda Ianniello

Cover Shot

Nembrotha kubryana nudibranch scenting food (tunicates), Indonesia

© Linda Ianniello
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954-829-3955

Sharon Baron
305-775-7092

Tips ‘N Tricks

How to prepare images for submission to the Veolia 
Environment Wildlife Photographer of the Year Competition. 
This is straight from the competition rules page. http://www.nhm.

ac.uk/visit-us/whats-on/temporary-exhibitions/wpy-entry/Rules.jsp

I thought I would take a moment to show you what kind of rules are out there, this 
is pretty good info to have in the back of your mind & it cross compares 
Photoshop-->Lightroom--> and Apple Aperture.

Duplicate or make a copy of the image to be submitted: it is not advisable to work 
on original images. Clear tags, such as ratings and labels. 
Insert full picture information into the Caption field 
Full scientific name of main species featured. 
Exact location including country information to confirm where image was taken. 
Detailed description of image including any behaviour observed, interesting 
background story, technical comments. 
How the image was taken ie multiple exposure, if bait used etc. 
Entrants should not include their name in the caption or the image title or on the 
image itself. 
Entrants should leave the EXIF details intact ie camera, lens, exposure etc. 
Here’s how too METATAG YOUR IMAGE:
In Adobe Photoshop: File>File Info>Description

In Adobe Lightroom: Library Module under the Metadata Tab>Caption field 
– complete caption and title fields. Clear tags, such as rating and labels.

In Apple Aperture: Show Inspector (I) and select Metadata Tab->General->Caption 
Resize your image to 1920 pixels on the longest dimension 
Here’s how to RESIZE YOUR IMAGE:
In Adobe Photoshop: Image>Image Size>set the longest dimension to 1920 pixels. 
Make sure that the check boxes for Constrain proportions and Resample image 
are checked and that the method is Bicubic. Please ignore the resolution field. 

In Adobe Lightroom: In the export dialogue under Image Sizing, check the box 
for Resize To Fit. From the dropdown, select Width & Height, set W:1920 H:1920 
pixels. Set the resolution to 300 pixels per inch. 

In Apple Aperture: Create an Export Preset in the Export Dialogue File->Export-
>Version, select ‘Edit’ from the ‘Export Preset’ list. Click on the ‘+’ in the bottom 
left corner of the Export Preset dialog. Name your export preset, and then set the 
image format to JPEG. Tick Include Metadata. Set ‘Size to:’ to ‘Fit within (Pixels)’ 
and both Width and Height to 1920 pixels. Set the DPI to 300. 
Color Space:
Set the Colour Space to Adobe RGB(98). Preferably use a calibrated monitor, 
allowances will not be made for poorly colour managed/corrected images. 

In Adobe Photoshop: Edit>Convert To Profile>Adobe RGB(98), under options 
the Engine should be set to Adobe (ACE), the intent to Perceptual or Relative 

Check out our contests page for more on this contest 
and more!



3

Mar 2011

Digital adjustment guidelines:
The faithful representation of what was captured at the time of the image being taken must be 
maintained. 
Localised adjustments are allowed if kept to a minimum and not changing the overall faithfulness of the 
image 
Allowances will not be made for poorly colour managed/corrected images 
Please ensure images are not over saturated 
Digital adjustments that are allowed 
removal of sensor dust spots 
removal of chromatic aberration 
removing background noise, in moderation 
levels in moderation 
curves in moderation 
colour in moderation 
saturation in moderation 
contrast work in moderation 
shadow and highlights in moderation 
sharpening (including selective sharpening) in moderation 
cropping in moderation and as long as a suitable high-res TIF file can be supplied for printing a large 
exhibition display 
dodging, burning and toning in moderation 
neutral density gradients in moderation 
removing lens vignetting 
panoramas ie panoramas created from several images that have been taken from the same location and 
at the same time, and then combined using digital techniques, and resulting in a wider view than can 
be achieved with most wide-angle lenses. Stitched Panoramas are only allowed in the Animals in Their 
Environment, creative Visions of Nature, Wild Places categories and the Young Wildlife Photographer of 
the Year and must be declared in the caption. 
Multiple exposures are only allowed if this is a feature of the camera and the result is one single file. 
Entrants must state in the caption if their image is a multiple exposure. 

Colormetric. Use Black Point Compensation should be checked and Use Dither should be unchecked. 

In Adobe Lightroom: the colour space setting can be found in the Export Dialogue under File Settings, 
simply choose Adobe RGB(98). 

In Apple Aperture: in the export preset, set the Colour Profile to Adobe RGB(98) and tick the Black 
Point Compensation. 
Save the file as a JPEG at the quality setting 10
Entrants should ensure that their files carry their own name, the category number or title, and key 
subject eg JbrownGeraldDurrell.eagle.jpg. All images should be labelled in the same format. 

In Adobe Photoshop: File>Save As> select JPG and set the quality to 10. 

In Adobe Lightroom: in the Export Dialogue under File Settings select JPG and set the quality to 100, 
leave the Limit File Size To box unchecked. Export. 

In Apple Aperture: in the Export Preset set the image quality to 10. 

Tips ‘N Tricks
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The SFUPS group went to Bonaire in September- October for the opportunity to capture the coral spawn in pristine waters.
by Carol Schurtz

Spawn to the left, spawn to the right, spawn up, spawn down and I only saw one coral spawn.    Get your sexiest t shirt on and join 
SFUPS for a great peep show from Bonaire!! Seriously anyone who has been to Bonaire knows how wonderful the water in that 
area is- Clear, Blue, Calm. Photos by Wayne McWilliams, Sharon Baron, Carol Schurtz, Kim and Bill Cook.
   
Buddy dive has a FANTASTIC  dive operation and the reef is a short swim to the wall.  There is a photo shop on the dock and I 
used quality rental gear. The best dive was a muck dive in the mangrove on the SW side of the island.  The town pier is closed 
unless you get special permission.  The Salt pier proved to be quite a challenge  with some rolling waves coming in fast and 
hard. We also had the opportunity to dive with Anna and Ned Deloach and other delightful divers.  The food is still expensive.  The 
rooms are very comfortable and the pool and bar are great. Every room had a truck so we drove all over the island.   Sharon 
spooked a whole flock of flamingos and I got the photo to prove it.  I broke my toe and have photos to prove that also.  The diving 
on the north side of the island was the best.  Wayne and Jeff did beach diving but it can be a difficult entry in many areas. 
  Hope to see you at the meeting!!! Mad Mermaid!

Presented by Sharon Baron

©Kim Cook

© Wayne MacWilliams
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Dear SFUPS Members,
Jonathan Lavan joined SFUPS last year, and flew out to be a speaker for us in February. 
He has got some interesting trips he is planning. These are not SFUPS sponsored dive 
trips. After meeting you all at the last meeting, he thought he would extend a courtesy to 
us in case you were interested in joining him. He does know his fish and has a really dry 
sense of humor! 

2 trips, that  Jonathan be leading, are available: 
  
Socorro Islands (Little Galapagos) southern Sea of Cortez- April 17-25, 2011 (yes 
that’s 9 days). 15% off base price of $3195! Not included: airfare to Cabo San Lucas, 
transfers to boat- $30.00, Nitrox- $100, Park fee- $25, alcoholic beverages. Loads of 
Sharks, Giant Manta Rays, Whales... 

Rocio del Mar- Midriff Islands, northern Sea of Cortez- 8/27-9/3/11, only 7 spots 
left- just $2195! Not included: airfare to Phoenix, AZ, shuttle (www.headdowntorockypoint.
com) from Phoenix airport to Puerto Penasco- $100.00, Nitrox- $100, Park fee- $25, alco-
holic beverages. Whale Sharks, Sea Lions, Dolphins, Humpback and many other whales 
and many fish and invert species seen nowhere else!  
  
Rocio del Mar (www.rociodelmarliveaboard.com). The only liveaboard to explore the north-
ern most reaches as well as the entire length of the Sea of Cortez . This special “mom & 
pop” boat owned and operated by Dora & Lolo Sandoval will provide you with a once in 
a life-time experience. The best of California and the Pacific coast of Mexico, this trip is 
truly a unique and exciting adventure for any diver or underwater photographer.  Please 
go to the website for a tour of the boat.  
  
There are other dates available. Please contact me for that information and any other 
questions you may have. I promise you it will be a trip you will not soon forget! 
  
See you Underpressure- 
  
Jonathan Lavan 
Underpressure Diving and Photography 
773-392-7767 
www.underpressure-spurdog.blogspot.com  



M A S T E R S   2 0 1 1    C H A L L E N G E R S   2 0 1 1  

MARCH Eggs Spring Flowers  - an underwater composition 
that resembles a flower or bouquet of flowers.

APRIL Out of the Darkness - Any subject against 
a black background.  Can be shot in the day or 
night.  Effect should be created in camera, not in 
the computer.

Green Flash - Subject matter should be primarily 
green in color.

MAY Upside Down - shot of an animal in an upside 
down position.  Example:  upside down jellyfish, 
filefish hovering with head pointed down, shrimp 
or crab hanging from the underside of a cave or 
ledge, etc. Please don’t just turn you photos over.
  

Wide Angle Wrecks - Wide angle view of any 
wreck .

JUNE Atlantic Lionfish - Any lionfish shot in Atlantic 
waters.

Your Best Tail Shot - Everyone has a butt shot, 
the one that got away.

JULY Creative Lighting - Think of using your strobes 
in a different way.  Might try backlighting or side 
lighting to create interesting shadow effect, snoots, 
etc.

Transparent - A subject you can see through.  For 
example, a Tunicate, Juvenile fish, a clear Shrimp or 
jellyfish.
 

AUGUST Shallow Depth of Field - Most interesting 
use of limited depth of field to emphasize part of 
a subject.  Only part of the subject (eyes, mouth, 
face, etc) in focus.  This does not mean a sharp 
subject against a blurry background.  Effect should 
be produced in camera, not in the computer.
 

Schools

SEPTEMBER Shooting Down - Best composition using a 
high viewpoint.  We normally shoot at eye level or 
looking up.  Try something different - for example, 
a  wide image looking down on a reef top, curves 
and patterns of the top of an eel.

Frames - Best composition with a natural element 
or manmade structure framing your subject at least 
three sides.

OCTOBER Little Devil - Evil looking critters, think Hallow-
een.

Shoot your Buddy - Wide Angle shot of another 
photographer doing his/her thing.  Camera must be 
visible.

NOVEMBER BIG Fish Wide Angle - A wide angle shot 
including a large fish as the primary subject.  Large 
fish might include goliath groupers, stingrays, bar-
racuda, etc.

Sharks - Any kind, from wide angle to macro.

2011 INTRA-CLUB PHOTO CONTEST SUBJECTS



DUES Were DUE in January
It’s time to pay your dues for 2011. The annual dues are:

$35.00 for an individual, $45.00 for a family.
$20.00 for an “Out of Area” non-participating membership.

Send your check, made out to “SFUPS,” to:

Sharon Baron
12710 SW 77th Street

Miami, FL 33183
(Or bring your check to the next meeting)

Mar 2011

Members in the News
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SFUPS

Woweee Fantastic job you guys!  Make us proud!
 
http://wetpixel.com/i.php/full/results-of-our-world-underwater-announced/    on page 1 of 8
Macro Unrestricted.
Honorable Mention Wayne MacWilliams, United States. “Star is Born”. 
Location: Bonaire.
--- --- ---
 
http://wetpixel.com/i.php/full/results-of-our-world-underwater-announced/P2/
Macro Traditional
Gold. Shen Collazo, United States. “Looking at me”. Location: Blue Her-
on Bridge- Palm Beach.
 
--- --- ---
http://wetpixel.com/i.php/full/results-of-our-world-underwater-announced/P4/
Wide Angle Traditional
Silver Christopher Guglielmo, Papua New Guinea. “Squid Fiesta”. Loca-
tion: Lighthouse Reef, Belize

ATTENCION, ATTENCION!!!! 
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WINNERS of  the INTRA CLUB CONTEST   
FEB: Masters:  WIDE ANGLE OPEN

1st Place: Linda Ianniello

Mar 2011

3rd Place: Wayne MacWilliams

5th Place: Christopher Guglielmo

1st  Place: Shen Collazo

2nd  Place: Christopher Guglielmo

4th Place: Mike Schmale

SFUPS
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WINNERS of  the INTRA CLUB CONTEST 

FEB:  CHALLENGERS:  Triggernomics

Mar 2011

1st Place: Judy Townsend

2nd Place: Bob Kaye

3rd Place: Deb Devers

4th Place: Ximena Olds

5th Place: 
George Ordenes

SFUPS



Strobe-less in Florida’s Springs 
by Ximena Olds & David Vanderveken

When the seas 
are rough, the surf 
is up and visibility 
is down, going 
out on an under-
water photo-ses-
sion isn’t much of 
an option. On the 
other hand, going 
diving in a fresh 
water spring is 
great on any given 
day, rain or shine. 
With a water tem-
perature of 72º 
F all year round 
and endless vis-
ibility, the only 
thing stopping 

you from shooting might be a lack of CF cards or worse, lack of imagination... 
We started at Ginnie Springs Outdoor, in High Springs. This is Florida’s most extensive cave system 
and is known worldwide from cavers like Wes Skiles, pioneer adventure photographer that helped 
charting the area. For more info about Wes Skiles and his photo work in the springs please check 
http://www.floridasprings.com/about.html

For non-technical divers photo options are endless. The biggest spring, Ginnie Spring, has a cavern 
that goes down to a depth of 50ft. The basin offers lots of potential for wide-angles; looking skyward 
you clearly see the tree line. It’s a good place to try half and half (bring a towel to clear water spots on 
the dry half) and experiment with different natural light throughout the day: catch the mist at sunrise 
to a full moon light. For the macro freaks, plenty of Hogchocker Sole (fresh-water tiny flounders) and 
Loggerhead Musk turtles. The loggerhead turtles are endemic to the Florida springs and have the 
ability to absorb oxygen through their skin and are the only turtles found in caves. An interesting chal-
lenge would be to photograph either one since they are fast and camouflage really good with their 
environment. 
About three hundred feet away lies the Devil Spring system and consists of three springs. Most of our 
time was spent at Little Devil, a 40ft deep narrow crack. Laying on the bottom, you can get some inter-
esting photos of your buddy floating at the crack’s mouth. From there, you can get to Santa Fe River 
for a drift dive downstream  back to Ginnie Spring. The dive is rich in bottom contrasts of the crystal 
clear spring water mixing with the yellow-ish river. You’ll see different species of fish like White Cat-
fish, Largemouth Bass, Sheepheads, Striped Bass, Gray Snappers, Mullets, Spotted Sunfish, Redeye 
Chubs, Bowfins and lots of turtles are there waiting to be photographed. The visibility can get pretty 
poor on some days. Do not attempt to do a drift dive from further upstream or you’ll look just like us: 
two beached whales in 2ft of water with our cameras all tangled up in tall grass...
Going back South we made a stop in Williston to Devil’s Den. The springs lays in a cavern with an 8ft 
opening where light comes through. Some fish there but not many. Poor light can challenge your pho-
tographic skills. Some may choose to get the strobes going or crank up the ISO and play with ambient 
light and contours. Most likely wide-angle territory here and some good opportunities to be creative. 
At Ginnie Springs we chose to stay at The High Springs Country Inn for $55 dollars a night and the 
entrance to the park was $30 dollars per diver with unlimited dives from 8am until midnight. Fills were 
$5 a tank. You have the option of a campground but we let it pass since we had batteries to charge 
constantly. A great addition to Ginnie is the hot water shower, pretty handy for divers used to warmer 
water. Bring your thick suit, gloves and hoodie if you are one of us. If you plan on staying the whole day, 

Mar 2011
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bring a cooler with your favorite drinks 
and food because they have great 
facilities with smokers and grills for you 
to use between your dives. 
While diving Devil’s Den we stayed 
at the Hampton Inn in Ocala for $74 
dollars a night with military or AAA dis-
count. The room was nice and freshly 
renewed and included breakfast. The 
Entrance to Devil’s Den was $35 dol-
lars and unlimited dives from 9 am to 6 
pm and $5 fills.
On a final note, this was one memo-
rable trip. The upside? Crystal clear 
waters, friendly people and of course, 
not having to rinse our gear after every 
dive... The flip side? A 5hr. drive and 
30º F for the last two days and putting 
on a frozen wetsuit but that just adds 
to the experience... Go. Dive. Shoot. 
Rinse. Process. Share... (in this case, 
of course, no rinsing involved).- Ximena 
Olds & David Vanderveken.
For more photos and information please 
check our photo travel blog: 
h t t p : / / w w w. t i m e z o n e t r a v e l l e r .
com/2010/12/02/florida-fresh-water-
spring/

Mar 2011SFUPS
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Digital Files: 
Realizing that some computer adjustments are necessary for digital files, we ask 
that only minor adjustments be made in the computer. Only minor cropping, color 
adjustments, backscatter removal and sharpening are allowed.  No extreme computer 
manipulation, removing items or adding items to the image. 
• Images will be submitted prior to the meeting so that they can be compiled for easy 
viewing and judging. 
• Image size should be no greater than 1024 pixels on the long side and the file size 
should be less than 
1.4 megabytes. Images should be submitted in JPEG format. 
• Each image file name must include your name, month, category, and number.  Use 
“mastr” for Masters Category and “chall” for Challengers category.  For example an 
image submitted by John Doe for the January Challengers contest would be named: 
JDoe-JanChall-1.jpeg  
• Entries must sent via email to Jim Mears at  audiovisual@sfups.org  by 12 noon on 
the Sunday before the meeting.

Once an image has won in any category, it must be retired from further competitions. 

Jim will send you a confirming email to let you know he has received the file.  Send to 

audiovisual@sfups.org

If you can’t find your newsletter- you can always check on our website. www.sfups.org        
For our new members, winning shots accumulate points throughout the year. Challeng-
ers may compete in both Challengers and Masters categories.  Only 2 entries per month 
-per person (except on the day contests). Masters are those who have previously won 
Photographer of the year, and they may only compete in the Masters categories. 

The person with the highest points wins the illustrious title of “Photographer of the 
Year” and is awarded a beautiful trophy.  Please see the website for the point system. 
Good luck!  Bonne chance!

2011 PHOTO CONTEST RULES

FUTURE 
INTRA-CLUB
CONTESTS

MARCH
M - Eggs
C - Spring Flowers

APRIL
M - Out of Darkness
C - Green Flash

MAY
M -Upside Down
C -Wide Angle Wrecks

JUNE
M - Atlantic Lionfish
C -Best Tail Shot

JULY
M - Creative Lighting
C -Transparent

AUGUST
M -Shallow Depth/field

C -Schools

SEPTEMBER
M -Shooting Down
C -Frames

OCTOBER
M - Little Devil
C -Shoot your Buddy

NOVEMBER
    VIDEO DUE
M - Big Fish Wide Angle

C -Sharks

DECEMBER
HOLIDAY PARTY
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                             THE CLASSIFIED’S

$1,500 for Seacam housing, $400 for camera or $1,850 for both. 
Wayne Mac WIlliams  shutterthethought@comcast.net

Mar 22 Veolia Environment Wildlife Photographer of the Year
             www.nhm.ac.uk
 Natural History Museum Up to 20 images. Very specific requirements.

Mar 28 Photo/Video Competition
 RSMAS  http://www.rsmas.miami.edu/outreach/underwater-photography/
 The University of Miami’s Rosenstiel School of Marine and Atmospheric Science is accepting submissions for the 
Annual Underwater Photography Contest, now through March 28th. The contest is open to amateur photographers who earn no 
more than 20 percent of their income from photography. Since its inception in 2005, the contest has drawn entrants from across 
the globe submitting more than 400 images per year. Photographs are judged in five separate categories: Fish or Marine Animal 
Portrait, Macro, Wide Angle, Student, and Best Overall. The winning images are announced at the Rosenstiel School’s Sea 
Secrets lecture on April 20th and are displayed in a traveling exhibit throughout the South Florida community. 
Winners will be announced at the Rosenstiel School’s Sea Secrets Lecture Series presentation on Wednesday, April 20, 2011 at 6:00 p.m. 
in the Rosenstiel School Auditorium, 4600 Rickenbacker Causeway, Virginia Key.
Please see our website for contest rules, entry form, and previous winners.

1. All entries must be received by midnight on Monday, March 28, 2011.  2.Contestants are limited to 3 entries per category. 

3.All entries must be high resolution digital files in JPEG format submitted electronically to photocontest@rsmas.miami.edu

Monthly Contest: for Emerging New Photographers!
http://chasingthelight.photoshelter.com
Chasing The Light Juried Photography presents outstanding, award winning images to over 1,200 select Professional Photo 
Editors and Art Directors as well as the general public on a regular basis. We maintain an up to date list of industry professionals 
who actively seek new talent and fresh images.
 
Our goal is to unite emerging new photographers with the Photo Editors and Art Directors of  the publishing world.  We are 
looking to discover those photographers who have the talent to turn the mundane into something extraordinary.

Talented photographers from around the world enter our themed competitions.  Any and all inquiries for publication and print 
sales are referred directly to the photographer per the contact information provided with each image.

Mac G4 Computer barely used  Jaguar o/s $650.00 obo ...
Suzan Meldonian   wussdiver@bellsouth.net



Parting Shot  
by 

Linda Ianniello

Linda Ianniello is
the SFUPS 
Featured 

Photographer
 for 

March 2011

Visit 
www.sfups.org

 to see 
our galleries

Your on-line gallery 
comes with your 

paid membership..
Take Advantage!

Mar 2011

JOIN

S
F
U
P
S

South Florida Underwater Photography Society
MEMBERSHIP INFORMATION

SFUPS is a Non-Profit Organization promoting interest in Underwater Photography 
and general awareness of our ocean’s creatures through photography. Meetings are 
held the second Tuesday of each month (January -November) at 7:30 pm at the El 
Palacio Hotel located at 21485 NW 27th Avenue off the Florida Turnpike, Miami, 
FL, 33056  305-621-5801 near Calder Raceway

Annual Dues are $35.00 (individual), $45.00 (family) and $20.00 for “Out of Area” 
non-participating members. Dues are payable each January. After June 1st, dues are 
pro-rated to 1/2 of the above for new members only.

A Membership form must be completed, signed and returned along with payment, a 
copy of your C-Card and dive insurance. Make checks Payable to SFUPS and send 

to:  SFUPS c/o 
Sharon Baron 

12710 SW 77 St., 
Miami, FL 33183

Membership forms can be found on our website at www.sfups.org and also available 
at the meetings, or contact Membership@sfups.org

© Linda Ianniello


